ANALISIS SOSIAL

STATISTIK NON PARAMETRIK




Statistik non parametrik adalah statistik yang tidak mendasarkan
pada parameter-parameter statistic karena data yang digunakan
adalah nominal / ordinal

= STATISTIK BEBAS DISTRIBUSI & UJI BEBAS ASUMSI
= STATISTIK BEBAS SEBARAN
+BANYAK DIGUNAKAN UNTUK PENELITIAN SOSIAL =» DATA NOMINAL / ORDINAL

a. Data nominal :

angka yang diberikan kepada objek mempunyai arti sebagai label saja, dan tidak
menunjukkan fingkatan apapun

b. Data ordinal:
memiliki nama (atribut), juga memiliki peringkat
mis: 1,2,3.,4,....dst, skala likert = tidak setuju sampai sangat setuju




KEUNGGULAN STATISTIK NON PARAMETRIK

+JIKA PENGUJIAN DATA =» SALAH SATU ATAU BEBERAPA ASUMSI UJI

STATISTIK PARAMETRIK TIDAK TERPENUHI =» STATISTIK NON PARAMETRIK
BISA DITERAPKAN

+PERHITUNGANNYA DAPAT DILAKSANAKAN DENGAN CEPAT DAN MUDAH
+DAPAT DITERAPKAN JIKA JUMLAH DATA SANGAT TERBATAS




KELEMAHAN STATISTIK NON PARAMETRIK

+BILA ASUMSI SEBARAN NORMAL TERPENUHI =» KESIMPULAN ANALISIS YANG
DIPEROLEH KEMUNGKINAN BIAS

+ TIDAK DAPAT DIGUNAKAN UNTUK MENGUKUR INTERAKSI
+TIDAK DAPAT DIGUNAKAN SEBAGAI ALAT UNTUK MENDUGA ATAU MERAMAL




CHI SQUARE

DIGUNAKAN UNTUK MENGUJI PERBEDAAN ANTARA FREKUENSI PENGAMATAN DAN FREKUENSI
YANG DIHARAPKAN

Latihan 1
Pemda X mengembangkan 7 fasilitas sanitasi kepada masyarakat.

Pemda mengharapkan ke -7 fasilitas tersebut memiliki tingkat penerimaan masyarakat yang
sama. Setelah 1 tahun dilakukan pengamatan berapa kali masyarakat memanfaatkan
program tersebut.
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LANGKAH 1: MEMBERI BOBOT DATA

= Buka file data

= Klik Data => Weight Cases pada
menu sehingga kotak dialog Weight
Cases muncul

File  Edit View

ype
zric

aric

L R | =

|

=l || T

Data View  Variable

Weight Cases...

| D

i Define Variable Properties...

2.4 Set Measurement Level for Unknown. .

Iz Copy Data Properties...

g2 New Custom Aftripute. ..

£ Define date and time...

Define Multiple Response Sets..
Validation

% Identify Duplicate Cases..

F7 Identify Unusual Cases. .

. Compare Datasets...

£ Sort Cases...

Sort Variables...

FE] Transpose...

B3 Adjust String Widths Across Files
Merge Files

FH Restructure...

B3 Rake weights...

|:| Propensity Score Matching...

B3 case control Matching...

FE! Aggregate. .
Orthogonal Design

EX spiitinto Files

T Copy Dataset

&= splitEile...

A select Cases...

Iﬂlﬂeight Cases..

Bentuk  Atur

- O >
Graphs  Utilities  Extensions  Window  Help II
M BN B 0% S
ues Missing Columns Align Measure Re |
a1l... None 8 = Right &5 Mominal “w Inpu=
None 8 = Right & Scale “w InpL

#

IBM SP3S Statistics Processor is ready Unicode:ON Weight On




= Pilih Weight Cases by dan masukkan variabel Frekuensi pada kotak Frequency Variable

= Klik OK

File  Edit View Data Transform  Analyze  Direct Marketing  Graphs  Utilities  Extensions  Window  Help
= A . = @ ﬂﬁ B T AN H > & A
B — ="' = ] FERL T i L T i . /
SEHE i e = & M| BROlFE g9 W O
ype Width | Decimals | Label Values Missing || Columns | Align Measure Re |
1 aric 8 0 2 Weight Cases w Right &5 MNominal “ Inpu=
2 aric 8 0 Right & Scale ™ InpL
3 © Do not weight cases
4 &5 Jenis jasa [fasilitas) @ Weight cases by
5 Frequency Variable:
G + |§Frekuensi pemakaian ...
7
a
9
10 Current Status: Weight cases by frekuensi
11
[ Ok ][Easte ][Eeset][{}ancel][ Help ]
12
13
14 =]
X P S S r— [*]
Data View | Variable View
IBM SP35 Statistics Processor is ready Unicode:OM Weight On
I
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#i@ “Output? [Document2] - IB e — O *
File Edit View Data Transform Insett Format  Analyze  Direct Marketing Graphs  Utilities Extensions  Window  Help e
- — — J— — — — I 1
& un - - O X
IEile Edit View Data Transform  Analyze Direct Marketing Graphs  Utilities Extensions  Window  Help
——— @ = N E | A
SEeHe~ BLA0 i B ¥ Bl «19% %
"""" | Name || Type || Width || Decimals || Label || Values || Missing || Columns || Align || !
1 fasilitas Numeric 8 0 Jenis jasa {1, jasal}...  MNone 8 = Right &b Ni=
2 frekuensi Numeric 8 13 Value Labels % = Right &5
3
4 rValue Labels
£ Label: [fasilitas 2 |
7
3 1="fasilitas 1"
- a0 ||2="fasilitas 2* |
10
i &R Untitled3 [Dat BM SPSS Statistics Data Edito - O *
12 '
13 File  Edit View Data Transform  Analyze  Direct Marketing  Graphs  Utilities  Exensions  Window  Help
- ok (cancel) _riep | —— == Je Ag]
4 SHELE -« B B B ¥ B 2199 4
’_‘|Dm“ew| Ll | MName | Type | Width | Decimals | Label | Values | Missing | Columns | Aign | 1
[ 1B SPSS Statistics Processoris ready| | | 1 |fasi|itas Numeric 3 0 Jenis jasa {1, jasal}...  None 8 = Right &b Ni=
frel-(uensi Numeric 8 2 Value Labels % = Right # s
4 rValue Labels
6 Izabel:l |
— e : T
.
2 ="fasilitas 2" |
III A 3 ="fasilitas 3" i
4 ="fasilitas 4~
_ 5 ="fasilitas 57
11 6 = “fasilitas § ]
12 7 ="fasiljfasZ_ - ]
7 N
13 \
14 OK cel Help e
1 [¥]
|Dala \HEW‘ Variable View 4
| |IBM SPSS Statistics Processoris ready | | [Unicode:ON|  [Weighton| |




LANGKAH 2: ANALISIS CHI SQUARE

= Klik Analyze =» Nonparametric Tests = legacy dialog =» Chi Square pada menu sehingga kotak
dialog Chi Square muncul

Quality Caontral

+\,|-l latihan 1_fasilitas.zav [DataSetd] - [BM SP55 Statistics Data Editor - O *
File  Edit View Data Transform tesb=a  Diesctblaceatina  Cronbe rl ilfips  Extensions  Window  Help
— = | Repw o b Fa .
! L;:__J e = Descriptive Statistics E % =4 ) &a\_}
ype Width | Decim LELE 55ing Columns Align Measure Rt
1 aric 8 0 Compare Means 8 = Right &> Nominal * Inpu
2 aric 8 0 General Linear Model B = Right & Scale * InpL
3 Generalized Linear Models
4 Mixed Models
5 Correlate
6 Regression
[ Loglinear
g Meural Networks [ chi-square...
g Classify [ZZ Binomial...
10 Dimension Reduction 1] Runs...
11 Scale [ 1-Sample K-5..
E Monparametric Tests % One Sample... [#8] 2 Independent Samples ..
1_‘1 Fnre.casilng n Independent Samples... mﬁlndependentSamples...
K Survival # Related Samples... [&] 2 Related Samples...
Data View!| Variable View Multiple Response Legacy Dialogs v | I K Related Samples..
Missing Value Analysis... '
Chi-square... Multiple Imputation Statistics Processor is ready Unicode:OM Weight On
Complex Samples W— Your Logo or Hame Here
% Simulation...




= Masukkan variabel fasilitas pada kotak Test VariablelLis, pilih Get from data pada kotak Expected
Range dan pilih All Categories equal pada kotak Expected Values.

L]
§ File Edit View Data  Transf| 82 Chi-square Test X lensions  Window  Help
— I =) TestVariable List =
. , . & Frekuensi pemakai... &5 Jenis fasilitas [fasilitas] — i
File Edit View Dals Window  Help
Options. .
1 Ah @ E fode, ﬂ . N A
B+ = 0 H‘ =] > 2o [@d 9
e [ MName | Missing Columns Align J
B4 fasilitas e 8 = Right & N=
2 frekuensi e B = Right &5
3
i Expected Range Expected Values
5 @ Getfrom data @ All categories equal
6 @) Use specified range @ Values:
=
8
q
10
1"
12
13 [ oK ][ Paste ][ Reset ][Cancel][ Help ]
! 14 =
i Iv]
=
Data View | variable View
IBM SPSS Statistics Processor is ready Unicode:OM Weight On

= Klik OK, sehingga Output SPSS Viewer menampilkan hasil sbb.:
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Jenis fasilitas

Observed M Expected M Residual - Tabel dl ataS memapa rkan 2 Macam
fasilitas 1 501 551.0  -50.0 frekuensi, yaitu frekuensi pemakaian
fasilias = 022 il L L fasilitas dan frekuensi pemakaian jasa
fasilitas 3 615 551.0 64.0 .
fasilitas 4 490 551.0 -61.0 yang dlharapkan. Sedangkan kolom
fasilitas 5 586 551.0 45.0 residual merupakan selisih frekuensi
fasilitas & 505 551.0 -46.0 d f k .
fasilitas 7 525 551.0 -26.0 pengamatan dan frekuensi yang
Total 3857 diharapkan.

Test Statistics

Jenis fasilitas

Chi-Square 37.405°
df ]
Asymp. Sig. 000

a. 0 cells (0.0%) have
expected frequencies
less than 5. The
minimum expected
cell frequency is
551.0.




Test Statistics

Jenis fasilitas

Chi-Square 37.405°
df G
Asymp. Sig. 000

a. 0 cells (0.0%) have
expected frequencies
less than 6. The
minimum expected
cell frequency is

= Tabel Test statistics memaparkan uji hipotesis 551.0.

v Hipotesis:

Ho = frekuensi pemakaian dengan frekuensi yang diharapkan sama

H1 = frekuensi pemakaian dengan frekuensi yang diharapkan tidak sama

Nilai %2 hitung = 37.405

Nilai 2 hitung = 37.405 > x* tabel 4., o5 = 12.59, maka Ho ditolak. Jadi frekuensi
pemakaian dengan frekuensi yang diharapkan tidak sama. Ada perbedaan minat
pemakaian setiap fasilitas

Bisa juga dengan melihat Asymp Sig (0.000) < o (0.05), maka Ho ditolak

(6;0.05) berasal dari (n-1)

NN X X

SN




Percentage Points of the Chi-Square Distribution

Degrees of Probability of a larger value of x .

Freedom 0.99 0.95 0.90 0.75 0.50 0.25 0.10 0.05 0.01
1 0.000 0.004 0.016 0.102 0.455 1.32 2.71 384 6.63
2 0.020 0.103 0.211 0.575 1.386 2.77 4.61 9.21
3 0.115 0.352 0.584 1.212 2.366 4.11 6.25 7.81 11.34
4 0.297 0.711 1.064 1.923 3.357 5.39 7.78 9.49 13.28
5 0.554 1.145 1.610 2.675 4.351 6.63 9.24 11.07 15.09
6 0.872 1.635 2.204 3.455 5.348 7.84 10.64 12.59 16.81
7 1.239 2.167 2.833 4,255 6.346 9.04 12.02 14.07 18.48
8 1.647 2.733 3.490 5.071 7.344 10.22 13.36 15.51 20.09
9 2.088 3.325 4.168 5.899 8.343 11.39 14.68 16.92 21.67
10 2.558 3.940 4.865 6.737 9.342 12.55 15.99 18.31 23.21
11 3.053 4.575 5.578 7.584 10.341 13.70 17.28 19.68 24.72
12 3.571 5.226 6.304 8.438 11.340 14.85 18.55 21.03 26.22
13 4.107 5.892 7.042 9.299 12.340 15.98 19.81 22.36 27.69
14 4.660 6.571 7.790 10.165  13.339 17.12 21.06 23.68 29.14
15 5.229 7.261 8.547 11.037  14.339 18.25 22.31 25.00 30.58
16 5.812 7.962 9.312 11912  15.338 19.37 23.54 26.30 32.00
17 6.408 8.672 10.085 12.792  16.338 20.49 24.77 27.59 33.41
18 7.015 9.390 10.865 13675 17.338 21.60 25.99 28.87 34.80
19 7.633 10.117 11651 14562 18338 22.72 27.20 30.14 36.19
20 8.260 10.851  12.443 15452  19.337 23.83 28.41 31.41 37.57
22 9.542 12.338  14.041  17.240  21.337 26.04 30.81 33.92 40.29
24 10.856  13.848 15659 19.037  23.337 28.24 33.20 36.42 42,98
26 12.198 15379 17.292 20.843 25336 30.43 35.56 38.89 45.64
28 13.565 16.928 18939 22657 27.336 32.62 37.92 4134 48.28
30 14953 18.493 20599 24478 29336 34.80 40.26 43.77 50.89
40 22.164  26.509  29.051 33660 39.335  45.62 51.80 55.76 63.69
50 27.707 34764 37689 42942  49.335 56.33 63.17 67.50 76.15
60 37.485 43.188 46459 52294 59.335  66.98 74.40 79.08 88.38




TWO RELATED SAMPLES TEST

Analisis melibatkan 2 pengukuran pada subyek yang sama terhadap suatu pengaruh atau
perlakuan tertentu

Analisis ini dapat dipakai untuk tipe data nominal, ordinal dan skala

Ada 3 uji Two Related Samples Test:
Sign =» menguji perbedaan pasangan pengamatan sebatas tanda (+) dan (-)
Wilcoxon = memperhatikan besarnya perbedaan tersebut
McNemar =2 menguji 2 variabel dikotomi yang bertipe data nominal dan ordinal




Latihan 2_Sign dan Wilcoxon

Survey tentang pengaruh sosialisasi pemilahan sampah terhadap tindakan pemilahan sampah yang
dilakukan pada 15 wilayah. Survey ini mengamati jumlah masyarakat yang melakukan pemilahan sampah
setelah diberikan sosialisasi pemilahan sampah dengan sebelum dilakukan sosialisasi. Berikut datanya

Variabel: - Tanpa sosialisasi
- dengan sosialisasi




= Klik Analyze => Non parametric Tests => Legacy Dialogs =>Two Dependent Samples pada

menu sehingga kotak dialog Two Related Samples muncul

12 Iatihan 2_perlakuan.sav [DataSetd] - IBM SPSS Statistics Data Editor - X
File Edit View Data Transform Analyze DirectMarketing  Graphs  Utilities Extensions  Window  Help
n‘% DJ = Reports ; -
— - Descriptive Statistics
Name Type Tables Values Missing Columns Align Measure Role ol
1 Tanpasosial... Mumeric Compare Maans one None 12 = Right & Scale N Input =
2 sosialisasi Mumeric General Linear Model one MNone 12 = Right 5{9 Scale Y] Input
3 Generalized Linear Models
'f Mixed Models
; Correlate
= Regression
3 Loglinear
3 MNeural Networks
10 Classify
I Dimension Reduction
12 Scale
13 Nonparametric Tests A One Sample..
14 Forecasfing M\ Independent Samples...
15 LUE] A Related Samples...
16 rv'!.gmple Response . (e 5 b IZ‘ ey
17 Missing Value Analysis
18 Multiple Imputation oy ErmrE
19 Complex Samples Eguns
20 B2 simulation.. [ -sample k-5
21 Quality Control [ 2 Independent Samples
22 ROC Curve... mﬁlndependentsamp\es..
ij Spatial and Temporal Modeling [ii] 2 Related Samples...
= [N K Related Samples... =
[+

E]

Data View | variable View

2 Related Samples.

IBM SPSS Statistics Processor is ready
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= Blok variabel Tanpa sosialisasi dan variabel sosialisasi dengan klik secara berurutan. Masukkan
pasangan variabel tersebut ke kotak Test Pair(s) List dengan klik tombol panah sehingga
muncul tulisan Tanpa-Promosi- Promosi. Pada Test Type, pilih uji Wilcoxon dan Sign.

a @ Two-Related-Samples Tests *
jons  Window  Help
Test Pairs: [ Exact... ] s B
ﬁ Tanpa sosialisasi[.. Pair Variable1 |Var|ab| 2 | s = ﬁ -*—-4_ | *_./'
A | ¢ sosialisasi 1 Tanpas.. [sosiali... Options...
2 | Missing Columns Align Measure Role
« " =R \ e
Mone 12 = Right & Scale “ Input
Mone 12 = Right & Scale “ Input
Test Type
¥l Wilcoxon
¥ sign
[T MeNem
|| Marginal Homogeneity
[ OK ][Easte ][Beset ][Cancel][ Help ]

12
13
14
15
16
17
18
19
20
21
22
23
24

- Klik Options sehir___=— s, pilih

“1 16 dari 24 - Papan Klip

. Item tidak dikumpulkan: Hapus item
D e S C rl pt I Ve d a n p IBM SPSS Statistics Processoris rea un n ruang tersedia.
| i A = . =

4y BO2PM
0D @ D) g0 B
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= Klik Options sehingga kotak dialog Two Related Samples: Options, muncul. Pada Statistics, pilih
Descriptive dan pada MissingValues, pilih Exclude cases test by test.

la
I it
Fi Test Pairs: 7
= Exact..
ﬁ Tanpa sosialisasi[... - fmee s R + :
~ | ¢ sosialisasi L) iali... ]_

M Statistics ¥

[ Descriptive [7] Quartiles

Missing Values |
(@ Exclude cases test-by-test

@ Exclude cases listwise

[Quminue][ Cancel ][ Help ]

[ Marginal Homogenety

[ QK ][ Paste ][ Reset ][Cancel][ Help ]

12

= Klik continue lalu OK
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Descriptive Statistics

I Mean Std. Deviation  Minimum  Maximum Test Statistic 53
Tanpa sosialisasi 15 107.33 32.231 A0 165
L sosialisasi-
sosialisasi 15 131.33 3.762 G5 180 Tanpa
sosialisasi
Wilcoxon Signed Ranks Test .
£ 34T
Rank e
anks - Asymp. Sig. (2-tailed) 001
N__ [MeanRank | Ranks a. Wilcoxon Signed Ranks Test
sns?al?sas? - Tanpa Megative Ranks 0® .00 .00
sosialisasi Bositive Ranke e 8.00 12000 b. Based on negative ranks.
i Ties 0®
Total 15 = Hipotesis:
8. sosialisasi < Tanpa sosialisasl = Ho = Tidak ada perbedaan signifikan perilaku pemilahan sampah
b. sosialisasi = Tanpa sosialisasi L .
¢. sosialisasi = Tanpa sosialisasi sebelum dan setelah sosialisasi
= H1 = Ada perbedaan signifikan perilaku pemilahan sampah

sebelum dan setelah sosialisasi

Tabel Test Statistics memaparkan analisis hipotesis. Nilai Asymp.Sig (2-tailed), nilainya (0.001) < %2 o
sehingga Ho ditolak. Jadi ada perbedaan signifikan pada pada kegiatan pemilahan sampah sebelum
dengan sesudah sosialisasi.




Sign Test = Tabel Frequencies sama dengan tabel Ranks pada

Frequencies uji Wilcoxon. Bedanya,tabel ini tidak
N memperhatikan besaran, hanya sebatas (+)dan (-)

sosialisasi- Tanpa Megative Differences? 0
sosialisasi " _
Positive DIffEI'EI ; .
— =~ B Hipotesis:
[=3]
- = B Ho = tidak ada perbedaan signifikan perilaku pemilahan
a. sosialisasi = Tanpa sosialisasi Sampah dengan dan tanpa SOSiaIisaSi
b. sosialisasi > Tanpa sosialisasi o H1 = ada perbedaan signifikan perilaku pemilahan
¢. sosialisasi=Tanpa sosialisasi sampah dengan dan tanpa sosialisasi

= Test Statistics memaparkan analisis hipotesis. Nilai
Asymp.Sig (2-tailed), nilainya (0.000) < %2 o

Test Statistics®

sosialisasi-

Tanpa sehingga Ho ditolak. Jadi ada perbedaan yang
S0s1alls4as]
Exact Sig, (2-tailed) @ signifikan pada masyarakat yang melakukan

a. Sign Test pemilahan sebelum dan sesudah sosialisasi

b. Binomial distribution used.




Latihan 3_ dengan dan tanpa punishment

Seorang kepala desa melakukan pengamatan terhadap perilaku masyarakatnya dengan melakukan
program punishment terhadap perilaku membuang sampah di sungai. Kepala desa tersebut
mengambil 15 responden secara acak.

)
File  Edit View Data Transform  Analyze  DirectMarketing Graphs  Ulilities  Extensions  Window  Help

= T . A B &S (2 ABC,
=i 1= o o B B 4| gl D *9

MName Type Width Decima Is Label Values Missin g Columns Align Measure Role
1 Tanpapunis... Numeric 22 0 Tanpa punishm__. None MNone 22 = Right &5 Nominal *w Input “
2 denganpuni... Mumeric 22 0 dengan punish... MNone MNone 22 = Right &5 Nominal N Input
3
4
5
6 3 Value Labels >
; Value Labels
10 Label: |tidak membuang sampah di sungai |

11 0 = "tidak membuang sampah di sungai”

2 :] 1 ="membuang sampah di sungai®

13

14
Remove
=

16
17
18
19

1 i ———————

[ ok |[cancel|[ Hep |

21

24

E] [H]

Data View | Variable View

IBM SPSS Statistics Processor is ready
o 04 PM

D 7 ) g B
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= Klik Analyze => Non parametric Tests => Legacy Dialogs =>Two Dependent Samples pada menu

sehingga kotak dialog Two Related Samples muncul

*Untitled [DataSet5] - IBM SPSS Statistics Data Editor - X
File Edit View Data Transform Analyze DirectMarketing Graphs  Utilites  Extensions  Window  Help
— # _J_IJ = Reports J g B A :Jj I * b %
! iy 4 v
— u == Descriptive Statistics [ @ [ @
Name Type Tables Values Missing Columns Align Measure Role o
1 Tanpapunis... Numeric Compare Means 0. tidak me_.. Mone 22 = Right @5 MNominal “ Input =
2 denganpuni... Numeric General Linear Model 0. tidak me_.. Mone 22 = Right @0 Mominal N Input
: Generalized Linear Models
4
= Mixed Models
2
Correlate
[
= Reagression
'8 Loglinear
9 MNeural Networks
10 Classify
1 Dimension Reduction
12 Scale
13 Nonparametric Tests A One Sample..
14 Forecasfing A\ Independent Samples...
15 B A Related Samples...
g Multiple Response
16 HLAT B Legacy Dialogs 2 oy
o ) [ chisquare...
17 Missing Value Analysis
! [ Binomial
18 Multiple Imputation
19 Complex Samples I Runs.
20 B} Simulation B 1-Sample K-S..
2 Quality Control [ 2 Independent Samples...
22 ROC Curve mﬁlndependentSamples
23 -
2 Spatial and Temporal Modeling [i] 2 Related Samples..
— I K Related Samples .. =
[ F

Data View | Variable View

2 Related Samples...

“| 24 dari 24 - Papan Klip
ltern tidak dikumpulkan: Hapus item
untuk meningkatkan ruang tersedia.

%09 PM

IBM SPSS Statistics Processor is ready
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X

+\.r\ Two-Related-Samples Tests
jons  Window  Help

E Test Pairs: -
_ = Eyact... == & Al
] &5 Tanpa punishment ... Pair \Var\ableﬂ |Variab|e2 \ S48 g M%
A | & dengan punishme... 1 @b Tanpap.. g5 dengan ... + E [Ad <&
2 [ Missing Columns Align Measure Role
¥ Mone 22 = Right &5 Mominal “w Input =
Mone 22 = Right &5 Nominal “ Input
Test Type

| Wilcoxon

[+ McMemar
[”] Marginal Homogeneity

(L ox s ) oot cancr) o |

12
13

15
16
17
18

19

21
22
23
24

ar

cul

[4]

[1

Data View | Variable View

IBM SPS5 Statistics Processor is ready

Unicode:ON

= Klik continue
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L =

Test Pairs:
= f T T
& Tanpa
& dengan punishme, 3 Two-Related-Samples: Options X ,.J
Statistics
[¥:Descriptive [ Quartiles
Missing Values
@® Exclude cases test-by-test [
© Exclude cases listwise
[T T WargIar HOMOgeneny
o T
12
13
14
15
16
17
18
19
20
4
22
23
24

fons  Window  Help

A ei0®

| Missing | Columns Measure
None 22 @5 Nominal
Mone 22 &> Nominal

Role
“ Input
N Input

[AT

|E]

1B SPSS Statistics Processor is ready

= Klik OK
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McNemar Test

Crosstabs

Tanpa punishment & dengan

punishment
dengan punishment
Tanpa punishment 0 1
fidak membuang 2 ]
sampah di sungai
memhbuang sampah di 2 3
sungai
Test Statistics”
Tanpa
punishment &
dengan
punishment
[+ 15
Exact Sig. (2-failed) 10gP

a. Mchemar Test

b. Binomial distribution used.

= Hipotesis:

= Ho = tidak ada perbedaan signifikan perilaku membuang
sampah di sungai dengan atau tidak ada punishmen

= H1 = ada perbedaan signifikan perilaku membuang sampah di
sungai dengan atau tidak ada punishmen

= Nilai Asymp.Sig (2-tailed), nilainya (0.109) > % o
sehingga Ho diterima. Jadi tidak ada perbedaan
signifikan perilaku membuang sampah di
sungai dengan atau tidak ada punishmen




Latihnan_5

pekerjaan.

= Pendidikan : 1 = lulus SMA

Responden | Pendidikan | Pekerjaan |Responden |Pendidikan| Pekerjaan
1 1 1 31 2 2
2 2 2 32 2 1
3 1 2 33 2 1
4 2 2 34 1 1
5 1 2 35 2 2
Apakah ada hubungan antara pendidikan dengan adanyg—: - : - : :
8 1 2 38 2 2
9 2 2 30 2 1
10 1 2 40 3 2
11 1 2 41 1 1
2 42 2
2 = |ulus S1 = : i s 1
14 2 1 44 2 2
3 = lulus S2 15 1 2 45 1 1
. .e . 16 3 2 46 3 1
= Pekerjaan : 1 = melakukan penghijauan di rumah = - - = - >
. .. . 18 2 2 48 2 1
2 = tidak melakukan penghijauan di rumah—:;: 1 1 - - ;
20 2 2 50 2 1
21 3 1 51 2 1
22 1 1 52 2 2
23 3 2 53 3 2
24 1 2 54 1 1
25 3 1 55 2 2
26 2 2 56 2 2
27 1 2 57 1 1
2 1 2 58 3 1
20 2 2 50 2 1
30 1 1 60 3 1







